# INTRODUCTION TO MICROSOFT ACCESS

Tables, Queries, Forms & Reports

Introduction ...................................................................................................................................................2
Tables ..............................................................................................................................................................3
   Designing a Table .....................................................................................................................................3
   Data Types .................................................................................................................................................4
   Relationships..............................................................................................................................................8
   Saving Object Designs and Saving Data ...............................................................................................9
Queries..........................................................................................................................................................11
   Select Queries ..........................................................................................................................................11
   Other Types of Queries.........................................................................................................................16
Forms ............................................................................................................................................................17
Reports............................................................................................................................................................25
   Summary Report .....................................................................................................................................25
   Creating Mailing Labels using Access Reports ...................................................................................28
Importing Data from Microsoft Excel.....................................................................................................33
Exporting Data to Microsoft Excel...........................................................................................................38
Resources for Learning and Troubleshooting Access ............................................................................39
Microsoft Access is a relational database application that is composed of four main objects:

- **Tables**: for storing data
- **Queries**: for viewing data
- **Forms**: for entering data
- **Reports**: for printing data

When you launch Access, your database window shows the different objects available to you on the left, and the items of the selected object type on the right:

In our sample below, the tables object is selected. There are three tables: contacts, contactType, and participants.

![Database Window](sample:Database (Access 2000 file format).png)

**Figure 1: The Database Window.**

Other objects not discussed here are Pages, Macros and Modules.
Tables

- Designing a Table
- Field Names
- Data Types
- Relationships

Tables are the heart of Microsoft Access because they contain the actual data. You should spend more time planning your tables than you do actually creating them. This will save you time in the long run.

Each Access database can contain hundreds of tables. Each table contains multiple records (displayed as rows) such as a people in an address book. Each record contains multiple fields (displayed as columns) such as phone numbers and street address.

**Designing a Table**

To design a table, make sure your tables object is selected in the database window and click New. Choose to open the new table in Design View, as shown in Figure 2.

![Figure 2: Creating a new table in Design View](image)

Why choose Design View? As shown in Figure 2, there are several ways to view Access objects, including tables. You can create a table in Datasheet View, Design View, or with the Table Wizard. You can also import or link to an existing table. We will not discuss these last two options.

As we will see, Design View allows you to design every detail of your new table. Datasheet View is much better suited for viewing, entering and editing data. You could also use the Table Wizard to create a new table, but doing so will not give you a good understanding of how tables work.
To enter fields in your table, fill in the Field Name and the Data Type for each field, as shown in Figure 3. The Field Description is optional.

A Note about Field Names

Although Access does not require it, it is common practice for field names to contain no spaces and begin with a lower case letter. It is important for your field names to be short, meaningful and easy to read. Here are some examples of bad and good field names:

<table>
<thead>
<tr>
<th>Bad</th>
<th>Good</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participant First Name</td>
<td>firstName</td>
</tr>
<tr>
<td>middle</td>
<td>middleInit</td>
</tr>
<tr>
<td>field1</td>
<td>lastName</td>
</tr>
</tbody>
</table>

Data Types

Each field in an Access table is of a particular data type. This defines the type of data that can be stored in it. The most common data types are:

**AutoNumber:** a number which is automatically incremented for each new record. This is ideal for unique identifiers, that is, a value that is unique for each record.

**Text:** can hold up to 255 text or numeric characters.

**Number:** can be any number.
**Date/Time:** used specifically for fields that will contain time or date values.

**Yes/No:** ideal for data which answers a Yes/No question, such as "Did we receive payment?"

**Currency:** specially formatted for dollar and cents data.

**Memo:** for fields that will hold large amounts of text.

---

**Figure 3: The Participants Table.**

The **participants** table contains basic contact information for participants in our sample study: salutation, first name, middle initial, last name, street address 1, street address 2, city, state, zip, phone and birth date. The ID field is defined as the **Primary Key** for this table (note the key symbol beside it). Primary keys are unique identifiers for each record in the table. We couldn't use lastName as the Primary Key because there might be more than one person with the same last name. The Primary Key is always a field that contains a unique value for each record.

In this example, we want to keep track of our contacts with our participants – when we contact them, how we contact them, and whether or not that contact is a success. Our second table, called **contacts**, contains data about these contacts.
Figure 4 shows that the contacts table also contains a unique ID field that is defined as the Primary Key. In addition, it contains a second ID field, called the participantID. This is referred to as a Foreign Key, because it relates to a specific record in another table (in this case, the participants table).

Figure 5: The Participants and Contacts Tables in Datasheet View
As you can see from Figure 5, the values of participantID in the contacts table are not unique. Instead, each value relates to a unique value of the ID field in the participants table. Records that contain a value of 1 in the participantID field in the contacts table relate to Mr. John A Doe in the participants table.

In this way, the participants table and the contacts table are related. Each person in the participants table is contacted multiple times, and so has multiple records in the contacts table. In our sample database, Mr. John Doe was contacted twice, Mrs. Jane Smith was contacted once, and Ms. James Jones was contacted 4 times.
Relationships

Let's look at another view of how the participants and contacts tables are related. Click the Tools drop-down menu and select Relationships, as shown in Figure 6. This will bring up the relationships window.
The black line between the two tables shows that there is a relationship between them. This relationship is between the ID field in the participants table and the participantID field in the contacts table. The infinity symbol next to the contacts table shows that this relationship is one-to-many. In other words, each record in the participants table corresponds to many records in the contacts table.

To create a relationship, click on the field in the main table that you want to use in the relationship, and drag it to the related field in the second table. To edit a relationship, double-click on the line between the two tables.

![Edit Relationships Window](image)

Figure 8: The Edit Relationships Window

The Edit Relationships window (Figure 8) specifies which tables are related, and which fields they are related by. At the bottom, "Relationship Type" reveals that this is a one-to-many relationship. Note that if you did not have any data in your tables yet, Access would have no way to know the relationship type. In our sample database, Access knows that there are multiple related records in the Contacts table for each record in the Participants table.

Also note that the box labeled "Enforce Referential Integrity" is checked. This means is that there cannot be a record in the Contacts table without a related record in the Participants table. This makes sense, because you cannot contact someone that does not exist.

Using multiple related tables helps keep table sizes small, and data more manageable. If we tried to do the same thing with just one table, we would need distinct fields for each contact. For example, we might have contactDate1, contactType1, contactSuccess1, contactDate2, contactType2, contactSuccess2, and so on.

**Saving Object Designs and Saving Data**

There are two levels of saving in Microsoft Access: saving the design of your object (like a table) and saving changes to the data. The save icon in the tool bar is used to save the design of whatever object you happen to be working on in design view. It is not used to save changes to data.

Let's say you have the Participants table open and you are making changes to the first record. Once you start making changes, a pencil icon appears on the left side of the window for that row, as shown in Figure 9:
<table>
<thead>
<tr>
<th>ID</th>
<th>salutation</th>
<th>firstName</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mr</td>
<td>John</td>
</tr>
<tr>
<td>2</td>
<td>Mrs.</td>
<td>Jane</td>
</tr>
<tr>
<td>3</td>
<td>Ms.</td>
<td>James</td>
</tr>
</tbody>
</table>

To save your changes, either click on the pencil icon, or click in a different row.
Queries

Select Queries

Our sample tables only have a few records, but most real tables have hundreds - even thousands of records. Searching through large tables for particular information is not efficient. That is where select queries come in. We use select queries to query the database, or ask it to show us information based on particular criteria.

When you run a select query, it produces a subset of the records in the table(s) that your query is based on. Those records still exist in the original table(s). Queries just give you a better way to view all of, or a subset of, the records in your table(s).

Let's say for example that we want to know which participants we have contacted by mail. Back in our database window, click on the query object, and then click New to create a new query.

![New Query Dialogue Box](image)

Figure 10: The New Query Dialogue Box.

When the New Query dialogue box appears, choose Design View. As with designing tables, it is best to use Design View for designing queries.
Next you will be asked which tables you want your query to show data from. Highlight the table you want to see data from and click "Add." You can add as many tables as you wish. Since we want to know about both participants and contacts, we add the contacts table, then the participants table.
Next decide which fields from each table you want to include in your query. To include a field, double click the field name. Let's include both first and last names from the participants table, and contactType from the contacts table.

![Figure 12: The Query Window with fields filled in](image)

Each field contains a place where criteria can be specified for that field. For example, if we only wanted to see participants whose last name is "Smith," we would type "Smith" into the criteria line for the field lastName. In this case, we only want to see participants whom we have contacted by mail, so we type "mail" into the criteria line for the ContactType field, as shown in Figure 12.

You can also sort the records that your query produces by the fields in your query – ascending or descending. To sort the records by last name, choose "Ascending Sort" for that field in the sort line, as shown in Figure 12.

You can use wildcard characters in your searches, too. For example, if you wanted to see all participants who have been contacted by mail and whose name started with the letter S, you would put "mail" in the criteria line for the ContactType field, and "S*" in the criteria line for lastName. The asterisk character stands for "any character or characters." When you click out of the criteria line, you will see that Access changes this to Like "S*".
Figure 13: Using Wildcard Characters and the And Operator in Searches

Criteria set for different fields on the same line indicates the word *and*. For example, in Figure 13, both Like "S*" and "Mail" are on the same line. That means "show me all the participants whose last name starts with the letter S and have been contacted by mail."
In Figure 14, "S*" is on the first criteria line, and "Mail" is on the second criteria line. This indicates the word or. This says "show me all the participants whose last name starts with the letter S or have been contacted by mail."

Click the red exclamation point in your toolbar to launch the query. Here are the results:

<table>
<thead>
<tr>
<th>lastName</th>
<th>firstName</th>
<th>contactType</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doe</td>
<td>John</td>
<td>mail</td>
</tr>
<tr>
<td>Jones</td>
<td>James</td>
<td>mail</td>
</tr>
<tr>
<td>Smith</td>
<td>Jane</td>
<td>mail</td>
</tr>
</tbody>
</table>

Figure 15: Query Results
The query results show only participants that were contacted by mail. When you run a query, you are looking at it in Datasheet View.

You can edit the data in your tables using queries in Datasheet View. **If you edit any of the data displayed in a query, you are actually changing the data in the table(s) that your query is based on.** You can also enter new records by clicking the [New Record] button. Any new records you enter will also be stored in your table.

If you want to edit your query, say, add more fields and criteria, you must switch from Datasheet View to Design View. To go back into Design Mode, click the design icon in your toolbar. If you think you might want to use this query again, remember to save it before closing it.

### Other Types of Queries

As discussed above, you can use select queries to select records from your tables based on criteria. Other types of queries are:

- Append Queries – used to append records from one table to another based on criteria
- Delete Queries – used to delete records from a table based on criteria
- Make Table Queries – used to create a new table containing records from another table (or tables).
- Update Queries – used to update records based on criteria

When working on a query in Design View, you can change the query type from the Query drop-down menu.

While select queries don't change the data in your tables, these other types of queries do. This makes them much more powerful and much more dangerous at the same time. Before you run an Append, Delete or Update query, take the following steps:

1. Make a copy of your entire Access database for back-up.
2. Make a copy of the table that you will be manipulating inside Access

Run your query as a select query to make sure that you are selecting the records that you want to append, update or delete.
Forms

Just as tables are an inefficient means of viewing data, they are also an inefficient means of entering new data. Creating forms to handle data entry in Access is simple, thanks to built-in wizards.

As with queries, any data editing or entry that you do using forms affects the data in the tables they are based on.

Click on the Forms object in your database window, and choose New.

![New Form Dialogue Box](image)

As shown in Figure 16, choose Form Wizard, and then choose the table or query that you want to base your form on from the drop-down list. I have chosen the participants table as my form source.
The Form Wizard will appear. The first step is to select which fields you want to include in your form. Select single fields by highlighting the field you want in the "Available Fields" list, and then click the button to move it to the "Selected Fields" list. You can select all the fields from your table by clicking the button. When you are finished, click the Next button.

Next, select a layout for your form and click the Next button. A preview of the form type is displayed in the left part of the window. In this example, we will choose Columnar, as shown in Figure 18.
Next, select a style for your form and click the Next button. In this example, we will choose Standard style, as shown in Figure 19.

Next, type in a name for your form, choose whether to open the form to view or enter data, or modify the form's design, and click Finish. Opening the form to view or enter information allows you to look at the finished product, while modifying the form design allows you to tweak the form further. In this example, we will name our form "enter participants" and choose to modify the form's design.
Here is the form we have created in Design Mode. Each of our fields has a label and a data-entry text box. All form objects are customizable, and can be controlled by clicking the properties button on the toolbar.

Headers and footers can also be customized. Form areas can be resized by clicking and dragging their boundaries.
To make it more useful, let's add a subform to our form that contains contact data for each participant. First, make the form area larger by clicking on the edge of the dotted-gray area and dragging it to the right. Then click the subform button on the toolbar (as shown in Figure 22) and click in an empty area of your form. The subform dialogue box will appear.

![Figure 23: The Forms Toolbar](image)

The Subform Wizard will guide you through the creation of your subform. Choose Use existing Tables and Queries, and then click the Next button.

![Figure 24: The Subform Wizard](image)
Choose the table or query that you want to base your subform on, then choose which fields from that table or query you want and click the Next button.

Next, you need to tell Access how the data source of your main form is linked to the data source of your subform. Because we have established a relationship between the participants and contacts tables, Access already suspects that we want to use the ID field to link these tables. Click the Next button.

In the next screen, give your subform a name and click Finish.
Figure 27: The enter participants Form with Subform in Design View

You can move your subform around and resize it by clicking and dragging. When you are satisfied, click the View button on your toolbar to see the form in Form View. Going to Form View shows you how a finished form looks.
Figure 28 shows our new form in form view. As you can see, not only does it display data for each participant, but data on each contact for each participant, all in one place. The record navigation buttons at the bottom of the form and the form and subform can be used to move from record to record.

Click on the new record button \( \rightarrow \) to enter a new record. All data entered via these forms is stored in your Access tables.
Reports

Access reports are used for printing data summaries, charts and labels. Like forms, they can be time consuming to create by hand. Access offers Auto Report Wizards to help in the report creation process.

We will create two reports based on our sample database: a report of participants, and participant mailing labels.

Summary Report

Like forms, reports can be based on tables or queries. You could base a report on a table, but then you would get all the data in your table in the report. It is much more likely that you would want to create a report for a specific purpose, and base it on a query created specifically for that purpose. In our current example, we might want to create a report of participants that includes all contact information.

To accomplish this goal, we will create a new query that includes all of the fields from the tables that contain data that we want included in our report. After that, we will create our report.
The query in Figure 29 uses all fields from both the participants and contacts tables. You can choose all fields from a table by double-clicking the asterisk in each table. I have named it "participants and contacts." Save and close it.

![Figure 29: Query Using Fields from Two Tables](image)

Now it is time to create the report. Back in your database window, click on the Reports object, and click New. From the list on the right, select AutoReport: Columnar, and the table or query that you want to base your report on.

![Figure 30: The AutoReport Wizard](image)
Click the OK button, and your report will be created and shown in Preview Mode.

<table>
<thead>
<tr>
<th>contactsID</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>participantID</td>
<td>1</td>
</tr>
<tr>
<td>contactDate</td>
<td>3/6/2001</td>
</tr>
<tr>
<td>contactType</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>In person</td>
</tr>
<tr>
<td></td>
<td>email</td>
</tr>
<tr>
<td>contactSuccess</td>
<td>✓</td>
</tr>
<tr>
<td>participantID</td>
<td>1</td>
</tr>
<tr>
<td>salutation</td>
<td>Mr.</td>
</tr>
<tr>
<td>firstName</td>
<td>John</td>
</tr>
<tr>
<td>middleInitial</td>
<td>A</td>
</tr>
<tr>
<td>lastName</td>
<td>Doe</td>
</tr>
<tr>
<td>streetAddress1</td>
<td>123 Main Street</td>
</tr>
<tr>
<td>streetAddress2</td>
<td></td>
</tr>
<tr>
<td>city</td>
<td>Detroit</td>
</tr>
<tr>
<td>state</td>
<td>MI</td>
</tr>
<tr>
<td>zip</td>
<td>48209</td>
</tr>
<tr>
<td>phone</td>
<td>(313) 555-121</td>
</tr>
<tr>
<td>birthdate</td>
<td>11/2/1961</td>
</tr>
</tbody>
</table>

Figure 31: A report in Preview Mode

Preview Mode is for seeing how a report will look printed. You can also view your report in Design Mode, where you can change the properties of every object on your report.

This was an extremely simple example of creating a report using the AutoReport feature. Access reports can get much, much more complicated than this.
Creating Mailing Labels using Access Reports

Create mailing labels in Microsoft Access is very easy. Let's say that we want to create mailing labels for everyone in our participants table who has had a successful mail contact in the past.

Before we begin creating the report, we need to create a new query that selects only people who have had a successful mail contact from the participants table. I include the contactType and contactSuccess fields from the contacts table, and the name and address fields from the participants table. For contactType I type in "Mail" for the criteria, and for contactSuccess I type in "Yes" for the criteria.

I uncheck the "Show" boxes for contactType and contactSuccess, although these serve to gather the relevant data, they do not need to appear in the report.

Note: If you want to create mailing labels for every person in your table, you do not need to create a query. You can base the labels report on your table instead.

Figure 32: Successful Mail Contacts Query

Be sure to save and close your query. I have named this query "Success Mail Contacts."
Back in your database window, choose the reports object, and New. In the new report dialogue box, choose the Label Wizard, and the table or query that you wish to base your report on.

Here, if you wanted to create mailing labels for everyone in your participants table, you would choose the Participants table as the source for the report. But since we only want to create mailing labels for participants who have had a successful mail contact in the past, we will select our new query, Successful Mail Contacts.

Figure 33: New Report - The Label Wizard
Next, choose the type of label you want to use by Product Number. Access provides a large assortment of predefined mailing labels. You can also create your own custom labels. Look at your labels to see if they are sheet-feed or continuous, what brand they are, and what number they are. I have chosen sheet-feed, Avery 5160 labels.

![Figure 34: The Label Wizard - Choosing Labels](image)

Next, choose the font name, size, weight and color of the font that will appear on your labels. The larger the font size you choose, the less text will fit on each label. I typically choose Arial size 10, normal weight.

![Figure 35: The Label Wizard - Choosing Font](image)
Next, insert your data fields onto the prototype label one at a time. The prototype label reflects how your finished label will look. Highlight a datafield on Available Fields list on the left and move it to the Prototype Label on the right. You can use your keyboard to insert spaces and characters between fields, and hit the Return or Enter key to go to a new line.

![Label Wizard](image)

Figure 36: The Label Wizard - Adding Fields To Your Labels

Next, choose how you want your labels to be sorted.

![Label Wizard](image)

Figure 37: The Label Wizard - Sorting Labels

Once you have finished designing your labels, give your report a name and click Finish.
Figure 38: The Label Wizard - Naming Your Report

Figure 39 shows our finished labels. Because we only have one person in our participants table that has had a successful mail contact, only one label appears on the page. A real label page based on a large table would be filled with names and address in rows and columns.

Mrs. Jane S. Smith  
2000 Central Street  
Detroit, MI 48209

Figure 39: The Labels Successful Mail Contacts Report
Importing Data from Microsoft Excel

Let’s say that you have an Excel spreadsheet that you would like to import into Access as a table. Doing so is simple. Make sure that your Table object is selected in the database window, click the File drop-down menu, and choose "Get External Data." You will see two choices:

1. Import – for importing data from another application like Excel
2. Link Tables – for creating a link to a table in another Access database. This is very useful because when the data in the linked table is updated, the updates show up in your database.

Choose Import to import an Excel spreadsheet.

Figure 40: The Import Dialogue Window

Change the Files of Type to Microsoft Excel (*.xls) and navigate to the Excel file that you would like to import. Once you have it selected, click the Import button.
In the first screen of the Import Spreadsheet Wizard, check the box labeled "First Row Contains Column Headings" if that is indeed the case. Access will use these values as field names for each column.

Figure 41: The Import Spreadsheet Wizard

You can store your data in a new table or in an existing table.

Where would you like to store your data?
- In a New Table
- In an Existing Table: ___
Figure 42: The Import Spreadsheet Wizard

Next, say whether you want to import the data in the spreadsheet into a new table, or a table that already exists.

Figure 43: The Import Spreadsheet Wizard

In the next screen you can change field names and choose not to import certain fields.
In the next screen, Access wants to know whether or not this table will have a Primary Key. You can either allow Access to create a Primary Key field (using an AutoNumber datatype field called ID), choose an existing field to be Primary Key, or have no Primary Key in this table. In this case it doesn't make sense to have a Primary Key field, so we will choose the latter.
Figure 45: The Import Spreadsheet Wizard

In the final screen of the Import Spreadsheet Wizard, you can give your newly imported table a name.

When Access finishes importing the data, it will let you know:

Figure 46: The Import Spreadsheet Wizard

You can import data from other file formats as well, including Access, Dbase, Exchange, Lotus, Outlook, Paradox and HTML documents.
Exporting Data to Microsoft Excel

Exporting Access tables and queries to Excel and other applications is just as easy as importing it. In the database window, choose the table or query that you want to export, click the File drop-down menu and choose Export. Like with importing, choose the type of file you want to create, navigate to the location where you would like to export to, and click Export:

![Figure 47: The Export Table Wizard](image)

Your data will be exported in a single step. Figure 46 shows the Participants table as an Excel spreadsheet:

![Figure 48: The Participants table as an Excel spreadsheet.](image)

As with importing, you can export Access tables and queries to other file formats as well.
Resources for Learning and Troubleshooting Access

Use the following resources to find help with Microsoft Access:

Access' Help System: Click the Help drop-down menu or press the F1 key to get help while working in Access. In Access 2000, the Help System includes a Table of Contents, an Answer Wizard, and an Index.

The Manual that came with your software.


The Microsoft Knowledge Base at http://support.microsoft.com/

The Microsoft Community Newsgroups at http://support.microsoft.com/newsgroups/default.aspx Click the plus sign next to "Desktop Applications" in the left-hand navigation and choose whichever Access topic seems relevant. Post a question and check back to see if it gets answered.

There are also many books available in your local bookstores on Microsoft Access. I do not have a current one to recommend.